
РЕДАКТИРОВАНИЕ СХЕМ
Панель Inspector в сочетании с не�

которыми другими (Find Similar
Objects, List) организует так называе�

мое глобальное редактирование, т.е.

одновременное изменение свойств

группы объектов. Рассмотрим приме�

ры глобального редактирования при�

менительно к схеме.

Первая задача – это выделение за�

данной группы объектов. Для этого

есть несколько способов выбора объ�

ектов, например, можно использо�

вать стандартные варианты выделе�

ния при помощи Shift+Click. Такой

подход оправдан при выборе незна�

чительного числа объектов или когда

имеется несколько типов объектов,

редактируемых одновременно и на�

ходящихся на одном листе.

Для выделения нескольких объек�

тов, которые могут при этом нахо�

диться на разных листах схемы,

используется команда Find Similar
Objects. Для открытия этого диалога

щёлкните ПКМ на одном из объектов

редактирования и выберите из кон�

текстного меню Find Similar Objects.

Рассмотрим данную процедуру на

конкретном примере, взятом из пап�

ки C:\Program Files\Altium Designer
6\Examples под названием 4 Port UART
and Line Drivers. Например, необходи�

мо изменить имя цепи питания на

схеме с –12V на –5V. Это потребует

изменения атрибута всех портов пи�

тания –12V на всех листах.

1. Необходимо обнаружить один из

данных портов на схеме, выпол�

нить на нём щелчок ПКМ и выбрать

Find Similar Objects (см. рис. 1), по�

сле чего появится окно, показанное

на рисунке 2;

2. Необходимо создать запрос, т.е. ука�

зать критерии выбора объектов на

схеме. Окно Find Similar Objects име�

ет три столбца. В первом перечисле�

ны параметры, доступные для дан�

ного типа объектов (набор этих па�

раметров изменяется в зависимости

от типа выбранного объекта), во

втором столбце указано текущее

значение параметра для выбранно�

го объекта, а в последнем столбце –

критерий выбора. Для каждого па�

раметра объекта можно установить

такие свойства сравнения, как Same
(одинаковый), Different (другой)

или Any (любой). В рассматривае�
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позволяют вносить одинаковые изменения для различных групп
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мом примере нас интересуют порты

питания –12V, поэтому необходимо

в строках Object Kind (тип объекта) и

Text указать критерий выбора Same;

в результате данный запрос приме�

няется к портам питания Power
Object со значением –12V (см. выде�

ления на рисунке 2). Все остальные

параметры имеют значение Any, т.е.

эти критерии безразличны для дан�

ного запроса;

3. После установки критерия выбора

необходимо указать область дейст�

вия запроса (см. на рисунке 2) и

выбрать команду для запроса (см.

на рисунке 2). В данном случае ука�

зываем область действия Open Do�
cument (предполагается, что уже

открыты все листы схем проекта) и

включаем параметры Select Match�
ing и Run Inspector.

С выбранными объектами можно

выполнить следующие действия:

● Zoom Matching – масштабировать

выбранные объекты во весь экран;

● Clear Existing – снять выделение с

ранее выбранных объектов;

● Mask Matching – наложить маску на

выбранные объекты (при этом объ�

екты, не попавшие в выделение, бу�

дут затенены);

● Select Matching – выделить выбран�

ные объекты, чтобы к ним можно

было применить действия;

● Create Expression – сформировать

запрос для панели Filter, при этом

запрос будет сохранён в истории и

может в дальнейшем использовать�

ся с меньшими трудозатратами;

● Run Inspector – запустить панель

Inspector.

Стоит запомнить, что панель Find
Similar Objects используется только

для формирования запроса на выде�

ление объектов определённого типа.

Эта панель не используется для изме�

нения свойств объектов!

После выбора указанных настроек

и нажатия клавиши ОК запускается

панель Inspector (см. рис. 3). Основ�

ная задача панели Inspector – вывести

список свойств выбранных объектов.

Набор выбранных объектов может

быть только одинакового типа.
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Рис. 1. Запуск панели Find Similar Objects

Рис. 2. Выбор объектов по заданным

критериям



Свойства, идентичные для всех

выбранных объектов, получают ото�

бражение их значений, например, в

данном случае показан цвет портов

питания (Color), стиль порта питания

(Power Object Style – Bar) и параметр

Show Net Name (отображать название

цепи). Для каждого свойства порта

питания, имеющего различные зна�

чения, будет указано <…> (например,

в позиции Х1). Это означает, что не

все пять объектов имеют одно и тоже

значение для Х1.

Кроме перечня свойств объекта, па�

нель Inspector имеет два параметра

для определения области действия

панели – Include, который устанавли�

вает ограничения на тип отображае�

мых параметров, и from, определяю�

щий документы, с которыми ведётся

работа. В нашем случае в параметре

Include имеется только один выбор –

Power Object (так как панель Inspector
была запущена из окна Find Similar
Objects), а в параметре from необходи�

мо выбрать Open Document of the Same
Project (открытые документы данно�

го проекта). В результате выполнения

всех действий в строке состояния па�

нели Inspector будет указано количе�

ство выбранных объектов и число

листов, на которых они находятся

(см. рис. 3).

Панель Inspector может быть ис�

пользована и для работы со свой�

ствами единичных объектов, что бо�

лее удобно, чем каждый раз захо�

дить в свойства объекта двойным

щелчком ЛКМ либо вызывать из

контекстного меню щелчком ПКМ.

При запущенной панели Inspector
свойства объекта, выбранного на

схеме, будут отображены в панели и

доступны для редактирования, при

этом не будет отображено стандарт�

ное окно свойств объекта, которое

закрывает собой большую часть до�

кумента.

4. Выбрав объекты и просмотрев их

свойства, можно перейти к редакти�

рованию необходимого параметра.

В рассматриваемом примере уста�

навливаем указатель мыши в строку

Text, вместо –12V вводим новое зна�

чение –5V и нажимаем Enter. После

проделанных манипуляций значе�

ние метки порта питания –12V изме�

няется на –5V на всех листах схемы.

При последовательном выполне�

нии описанных действий, после сме�

ны названий портов все другие объ�

екты на схеме маскируются (т.е. отоб�

ражаются светлее и недоступны для

редактирования). Чтобы снять мас�

кировку и продолжить работу с доку�

ментом, необходимо нажать комби�

нацию клавиш Shift+C.

Редактирование, которое выполня�

лось выше, относилось к простому

примитиву, т.е. одному из базовых

объектов, используемых в схемном

редакторе. Более сложные объекты,

такие как компоненты, называют сос�

тавными примитивами; они являют�

ся по существу набором простых

примитивов.

Рассмотрим пример типичного

сложного объекта, редактирование

которого необходимо выполнить.

Данный проект (4 Port UART and
Line Drivers) содержит несколько

конденсаторов 0,1 uF, для которых

необходимо добавить параметр

power (Напряжение питания). Дан�

ную процедуру проделаем в нес�

колько этапов:

● выберем все конденсаторы данно�

го типа;

● добавим новый параметр для кон�

денсатора;

● установим видимость добавленно�

го параметра.

Шаг 1. Выбор всех конденсаторов

0,1 uF в проекте

Находим на схеме конденсатор C4,

который принадлежит редактируе�

мой группе, нажимаем на нем ПКМ и

запускаем Find Similar Objects. Теперь

окно Find Similar Objects имеет не�

сколько другой вид – перечень доступ�

ных свойств гораздо больше, чем при

работе с простыми примитивами. За�

дадим запрос на выделение парамет�

ров следующим образом (см. рис. 4):

ограничение на позиционное обозна�

чение (С* – выбор только конденсато�

ров) и на комментарий (0,1 uF – выде�

лять только с данным напряжением).

Включаем параметры, как показано
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Рис. 3. Свойства группы портов

Рис. 4. Запрос для поиска конденсаторов



на рисунке 4. После нажатия кнопки

ОК запускается панель Inspector.

Шаг 2. Добавление нового

параметра

Для составных объектов в панели

Inspector имеется вкладка Parameters

(см. рис. 5), в которой перечислены

все параметры, назначенные для

выбранных компонентов. Чтобы до�

бавить параметр Power, устанавлива�

ем курсор в поле Add User Parameter и

вводим значение параметра 10 V, по�

сле чего нажимаем Enter. После ввода

значения параметра появляется за�

прос на ввод названия самого пара�

метра; здесь необходимо ввести его

название (Power). После проделан�

ных действий у выбранных компо�

нентов появился новый параметр, од�

нако, на схеме он пока не отображён.

Шаг 3. Отображение видимости

параметра компонента

Чтобы сделать добавленный пара�

метр видимым, необходимо менять

уже его свойства, а не свойства компо�

нента. Чтобы перейти к свойствам па�

раметра, следует выбрать его в панели

Inspector, после чего в ней появляются

свойства параметра, о чём свидетель�

ствует надпись Parameter в строке

Object kind, появившаяся вместо Part.
Следующим действием необходи�

мо выключить настройку Hide (см.

рис. 6), после чего на листе схемы по�

является значение параметра (10 V).

Теперь для возврата к свойствам ком�

понента следует выбрать строку Ow�
ner в панели Inspector (см. рис. 6).

При проектировании каждому ти�

пу объектов может быть назначено

несколько параметров, информация

о которых требуется для оформления

документации. Параметры докумен�

та используются для оформления

чертежей схемы и платы, параметры

компонента – для оформления пе�

речней и спецификаций. Все исполь�

зуемые параметры могут быть от�

редактированы индивидуально для

каждого компонента, однако при вы�

сокой плотности современных уст�

ройств это нерационально, а иногда

и невозможно. Как поменять пара�

метры для одинаковых компонентов,

было показано в предыдущих приме�

рах. Теперь рассмотрим, как изме�

нить параметры для различных объ�

ектов.

Для данной задачи используется

окно управления параметрами, кото�

рое вызывается по команде Parameter
Manager из меню Tools. Появляется

диалог Parameter Editor Option, в кото�

ром необходимо указать, с какими

параметрами ведётся работа.

В данном случае (см. рис. 7) выбира�

ем Parts, т.е. мы будем изменять пара�

метры компонентов; причём жела�

тельно включать настройку Exclude
System Parameters (исключить систем�

ные параметры). После нажатия кноп�

ки ОК откроется окно, показанное на

рисунке 8, в котором можно поменять

значение любого параметра.
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Рис. 6. Изменение свойств параметра через

свойства компонента

Рис. 7. Изменение параметров компонентов

Рис. 8. Изменение параметров различных компонентов

Рис. 5. Добавление нового параметра



Чтобы изменить значение группы

параметров, необходимо щёлкнуть

ПКМ на выделении и выбрать Edit, по�

сле чего можно ввести новый параметр,

который будет применён ко всей выде�

ленной группе компонентов. Важной

особенностью работы с данным ок�

ном является его поддержка внешни�

ми таблицами (например, в формате

Excel): можно копировать фрагменты

таблицы в программу MS Office Excel и

после редактирования вставлять об�

ратно. Следует отметить, что здесь же

возможно добавить новый параметр,

используя кнопку Add Column.

РЕДАКТИРОВАНИЕ БИБЛИОТЕК
После создания библиотек может

возникнуть задача внесения изме�

нений в графическую часть проекта.

Редактирование может затронуть

один конкретный символ и содер�

жать набор простейших процедур,

таких как изменение толщины ли�

ний или нумерации выводов. В этом

разделе будут рассмотрены вопро�

сы, касающиеся редактирования

нескольких компонентов или не�

скольких объектов на одном компо�

ненте, т.е. глобальное редактирова�

ние. Рассмотрим три самостоятель�

ных примера.

Пример № 1. Имеется символ мно�

говыводной микросхемы в станда�

ртной библиотеке Altium. Необходи�

мо адаптировать символ к требова�

ниям ГОСТ, т.е. поменять длину

выводов, выровнять их по сетке 2,5 мм

и изменить графику символа (в

большинстве случаев такой символ

рекомендуется нарисовать заново,

но рассматриваемый пример бывает

актуальным и в других случаях).

Рассмотрим решение поставленной

задачи на компоненте ADC�8, который

располагается в стандартной библио�

теке Miscellaneous Devices.IntLib. Чтобы

скопировать символ из исходной

библиотеки в библиотеку пользова�

теля, необходимо одновременно отк�

рыть обе библиотеки. Ранее (см. СЭ

№ 6, 2008) было показано, как созда�

ются библиотеки символов и библи�

отеки посадочных мест. В качестве

исходной библиотеки будет исполь�

зоваться интегрированная библиоте�

ка, которую можно открыть станда�

ртной командой File > Open, причём

при попытке это сделать на экране

будет показан вопрос (см. рис. 9).

Предлагается выполнить два

действия над библиотекой: Extract
Sources (извлечь) и Install Libraries (ус�

тановить). Установка библиотеки

требуется для последующего созда�

ния схемы из её компонентов, поэто�

му в данном случае выбираем Extract
Sources. В результате в панели Projects
будут загружены две библиотеки

(символы и посадочные места), объе�

динённые файлом проекта Miscella�
neous Devices.LIBPKG.

После этого открываем из панели

Projects библиотеку символов, нахо�

дим в ней компонент ADC�8 (через

панель SCH Library) и копируем его с

помощью команды меню, вызванной

ПКМ (см. рис. 10). Далее открываем

библиотеку пользователя, нажимаем

ПКМ в списке компонентов панели
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Рис. 9. Открытие интегральной библиотеки



SCH Library и выбираем команду Paste.

При необходимости копирования

нескольких компонентов их следует

выделять с нажатой клавишей Ctrl.

Первым действием исправим дли�

ну всех выводов компонента, для чего

необходимо выбрать их все. Нажима�

ем ПКМ на любом выводе компонен�

та и выбираем команду Find Similar
Object (найти подобные объекты), в

появившемся окне показаны свой�

ства Pin (вывод). Убеждаемся что в

нижней части включены все наст�

ройки, кроме Create Expression, и на�

жимаем кнопку ОК. В появившейся

панели Inspector изменяем длину выво�

да в строке Length на 2,5 мм (см. рис. 11).

Обратите внимание, что в заголовке

панели указано From Current Compo�
nent, т.е. действие применяется для

текущего компонента, а в общем слу�

чае данное действие можно было

применить ко всем компонентам

библиотеки (для этого на предыду�

щем этапе в панели Find Similar Object
требовалось указать область выбора –

все компоненты).

Теперь «привяжем » выводы компо�

нента к сетке 2,5 мм. Нажатием клави�

ши G добиваемся включения сетки

2,5 мм (если включена «миловая » сис�

тема координат, её необходимо пе�

реключить на метрическую через

Tools > Document Options). Не снимая

выделение с выбранных выводов, вы�

полним команду Edit > Align > Align To
Grid, что позволяет выровнять выде�

ленные объекты по активной сетке.

Последнее, что остаётся выполнить

для адаптации выбранного объекта к

отечественным ГОСТам, – перерисо�

вать графику символа. В данном слу�

чае проще удалить старый символ и

нарисовать новый. Таким образом, на

подгонку символа даже самой слож�

ной микросхемы может уйти не бо�

лее 2 мин.

Пример № 2. Имеется многовывод�

ная микросхема, создание символа

которой ведётся «с нуля». Для этой

микросхемы имеется справочный

листок Datasheet, в котором имена вы�

водов представлены в табличной фор�

ме. Ускорить создание такого символа

можно с помощью панели List.
Начало разработки такого симво�

ла ничем не отличается от обычно�

го, но при размещении выводов в их

свойствах задаются только номера,

поле Name остаётся незаполнен�

ным. Поскольку номера проставля�

ются автоматически, разместить

любое количество выводов не соста�

вит большого труда. После этого вы�

зываем панель List, которая может

быть запущена комбинацией кла�

виш Shift+F12. В этой панели (см.

рис. 12) показаны все объекты теку�

щего компонента, которые могут

подвергаться редактированию, в таб�
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Рис. 13. Выключение отображения точки привязки позиционного обозначения для компонентов

библиотеки

Рис. 12. Вставка нумерации выводов из таблицы в справочном листке

Рис. 11. Изменение длины выводов

микросхемы ADC,8

Рис. 10. Копирование компонентов

из библиотеки



личной форме. Панель List имеет че�

тыре кнопки управления, показан�

ные цифрами на рисунке 12:

● режим работы: View или Edit;
● объекты: Selected, Non Masked (не

выбранные), All;
● область: Current component, All com�

ponents;

● примитивы: из списка выбираются

примитивы, с которыми ведётся ра�

бота.

После выбора всех настроек, как по�

казано на рисунке 12, в таблице будут

показаны только свойства выводов.

Выравниваем таблицу по столбцу Pin
Designator по номерам выводов. Те�

перь в столбец Name необходимо

ввести названия выводов микросхемы

и здесь, даже вручную, эту задачу вы�

полнить гораздо легче, чем в поле ре�

дактора. Однако в нашем случае дан�

ная информация имеется в табличной

форме, поэтому копируем столбец с

названиями выводов из справочного

листка. Команды копирования, удале�

ния и вставки работают аналогично

данным командам в Excel.

Пример № 3. После импорта из

программы P�CAD некоторые линии

символов отображаются толще дру�

гих и все тексты имеют точку привяз�

ки. Необходимо сделать все линии

одной толщины и убрать отображе�

ние точки привязки для всех компо�

нентов библиотеки.

Для решения этой задачи, находясь

в режиме редактирования любого

компонента библиотеки, нажимаем

ПКМ на позиционном обозначении и

вызываем команду Find Similar Object
(если позиционные обозначения не

отображаются в библиотеке, то необ�

ходимо включить параметр Always
Show Comment/Designator в настрой�

ках Tools > Document Options). В окне

Find Similar Object задаём настройки в

соответствии с рисунком 13, причём

обращаем внимание на то, где будут

выбраны объекты (необходимо вы�

брать All Components, чтобы выбира�

лись объекты во всех компонентах).

После нажатия кнопки ОК запустится

панель Inspector, в которой также сле�

дует выбрать работу со всеми компо�

нентами (в верхней части панели, см.

рис. 13). Прежде чем вносить правки,

убедитесь, что в строке состояния па�

нели Inspector отображается общее

число позиционных обозначений,

равное числу компонентов в библио�

теке. После этого можно в поле

Autoposition поставить «галку», кото�

рая скрывает точку привязки текста.

Аналогичным образом исправляем

толщину линий по всем компонен�

там библиотеки.

РЕДАКТИРОВАНИЕ ОБЪЕКТОВ
НА ПЛАТЕ

Часто возникает необходимость

исправлять уже выполненные разме�

щение и топологию, для чего в Altium
Designer используются специфичес�

кие приёмы, знание которых позво�

ляет повысить эффективность рабо�

ты с программой.

Ранее было указано, что для ис�

правления свойств объектов необхо�
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Рис. 14. Выбор объекта на печатной плате



димо использовать панель Inspector,

хотя можно воспользоваться стандарт�

ным окном свойств объекта. Разница

заключается в том, что свойства вы

можете редактировать только для од�

ного объекта, а панель Inspector поз�

воляет работать с группой объектов!

Прежде чем изменить свойства или

расположение объекта, его необхо�

димо выделить. Рассмотрим особен�

ности одиночного и группового вы�

деления объектов в редакторе плат.

Для выделения одного объекта необ�

ходимо выполнить нажатие ЛКМ на

его графическом изображении, при

этом может появиться всплывающее

окно, показанное на рисунке 14. Дан�

ное окно появляется тогда, когда под

курсором находятся несколько объ�

ектов на нескольких слоях. Здесь не�

обходимо выбрать из списка тот объ�

ект, который следует выделить.

После выбора объекта, клавишей

F11 запускаем панель Inspector, где

для редактирования доступны все

свойства объекта. При редактирова�

нии проводника (см. рис. 15), на его

графике показаны метки (в центре и

по краям). При перемещении меток

изменяется форма сегмента, а при пе�

ремещении сегмента за свободную

часть изменяется его положение.

Причём во время редактирования то�

пологии работают те же режимы об�

хода препятствий, что и при создании

топологии. Например, на рисунке 15б

выделенный сегмент перемещается в

режиме Push (расталкивание тополо�

гии), а на рисунке 15в – в режиме Hug
(огибание).

Для редактирования нескольких

проводников их следует выделить,

для чего можно использовать два ре�

жима выделения: во�первых, нажав

клавишу Shift, можно поодиночке

выбрать необходимые объекты (к со�

жалению, если плата заполнена плот�

но, будет появляться окно рис. 14),

во�вторых, проводники можно выде�

лять с помощью команды Select.
Рассмотрим использование коман�

ды Select на примере, когда необходи�

мо передвинуть несколько параллель�

ных сегментов (см. рис. 16). Поскольку

все указанные сегменты расположены

на верхнем слое платы, командой

Shift+S переключаемся в однослойный

режим и делаем активным слой Top.

Нажимаем клавишу S, после чего на

экране отобразится контекстное меню

Edit > Select (см. рис. 16), из которого

можно выбрать режим выделения объ�

ектов. В первой группе здесь перечис�

лены стандартные для многих САПР

программы выделения объектов:

● Inside Area – выделить объекты, по�

павшие в рамку выбора;

● Outside Area – выделить объекты, не

попавшие в рамку выбора;

● Touching Rectangle – выделить объ�

екты, пересекающиеся рамкой;

● Touching Line – выделить объекты,

пересекающиеся линией.

Выбираем вариант Touching Line и

проводим линию по объектам, обве�

дённым зелёным контуром на ри�

сунке 17, после чего те сегменты то�

пологии, которые были пересечены

линией, будут выделены. Теперь

можно захватить ЛКМ свободное от

маркеров место любого сегмента и

передвинуть вверх все выбранные
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Рис. 17. Перемещение группы сегментов топологии

Рис. 18. Копирование фрагментов топологии

Рис. 16. Меню SelectРис. 15. Редактирование одиночного проводника

а) б) в)



объекты (результат показан на ри�

сунке 17 справа).

Если на плате расположены не�

сколько одинаково размещённых

фрагментов, которые обладают оди�

наковой топологией и ранее не были

реализованы в виде каналов на схеме,

можно скопировать топологию одно�

го участка на другой. Рассмотрим это

на конкретном примере (см. рис. 18),

где имеется четыре дифференциаль�

ные пары, у которых должна быть

одинаковая топология. После выпол�

нения трассировки одной пары, нахо�

дясь в однослойном режиме (для

удобства выделения), вызываем меню

Select (клавишей S) и в появившемся

списке выбираем команду Inside Area,

после чего рамкой обводим готовую

топологию дифференциальной па�

ры. Эту операцию можно выполнить,

просто выделив объекты рамкой, но

при этом велика вероятность, что слу�

чайно будет захвачен и передвинут

компонент или другой объект.

После выделения пары, комбина�

цией клавиш Ctrl+C копируем выде�

ленные объекты в буфер обмена (не

забывая, что программа при копиро�

вании требует указать точку привяз�

ки). Теперь, нажимая Ctrl+V, вставля�

ем из буфера выбранный ранее учас�

ток требуемое число раз, причём ес�

ли увеличить масштаб на участке,

отмеченном зелёным на рисунке 18,

можно заметить, что добавленная то�

пология имеет свойства тех цепей, к

которым он подключена.

Кроме описанных выше приёмов,

важную роль в редакторе плат, так же

как и ранее в других редакторах, игра�

ют инструменты глобального редак�

тирования. Рассмотрим их на наибо�

лее востребованном примере: имеет�

ся цепь, толщина которой 0,254 мм

(например, при трассировке конст�

руктор забыл указать, что толщина

берётся из правил, и значение было

установлено по умолчанию), и необ�

ходимо уменьшить толщину этой це�

пи до 0,2 мм. Для этого нажимаем

ПКМ на нужной цепи и выбираем ко�

манду Find Similar Objects. В появив�

шемся окне (см. рис. 19) помимо того,

что в верхней строке указан тип объ�

екта Track, указываем второй крите�

рий выделения в строке Name. Убеж�

даемся, что в нижней части панели

включены все параметры, кроме

Clear Expression, и нажимаем клавишу

OK. Напоминаем, что панель Find
Similar Objects предназначена только

для выбора критериев выделения

объектов и в ней нельзя изменить

свойства объектов!

После нажатия OK на плате будет

выбрана вся цепь, указанная в за�

просе. Теперь в панели Inspector
(F11) можно отредактировать тол�

щину цепи.
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Рис. 19. Выделение дорожек заданной цепи


